
Rational Software Corporation®

Rational® ClearCase LT®

Release Notes

VERSION: 2003.06.00

WINDOWS EDITION





Legal Notices

Copyright © 1992-2003 Rational Software Corporation . All Rights Reserved.
Version Number: 2003.06.00

This manual (the "Work") is protected under the copyright laws of the United States and/or
other jurisdictions, as well as various international treaties. Any reproduction or distribution
of the Work is expressly prohibited without the prior written consent of Rational Software
Corporation.

The Work is furnished under a license and may be used or copied only in accordance with the
terms of that license. Unless specifically allowed under the license, this manual or copies of it
may not be provided or otherwise made available to any other person. No title to or ownership
of the manual is transferred. Read the license agreement for complete terms.

Rational Software Corporation, Rational, Rational Suite, Rational Suite ContentStudio, Rational
Apex, Rational Process Workbench, Rational Rose, Rational Summit, Rational Unified process,
Rational Visual Test, AnalystStudio, ClearCase, ClearCase Attache, ClearCase MultiSite,
ClearDDTS, ClearGuide, ClearQuest, PerformanceStudio, PureCoverage, Purify, Quantify,
Requisite, RequisitePro, RUP, SiteCheck, SiteLoad, SoDa, TestFactory, TestFoundation, TestMate
and TestStudio are registered trademarks of Rational Software Corporation in the United States
and are trademarks or registered trademarks in other countries. The Rational logo, Connexis,
ObjecTime, Rational Developer Network, RDN, ScriptAssure, and XDE, among others, are
trademarks of Rational Software Corporation in the United States and/or in other countries.
All other names are used for identification purposes only and are trademarks or registered
trademarks of their respective companies.

Portions covered by U.S. Patent Nos. 5,193,180 and 5,335,344 and 5,535,329 and 5,574,898 and
5,649,200 and 5,675,802 and 5,754,760 and 5,835,701 and 6,049,666 and 6,126,329 and 6,167,534
and 6,206,584. Additional U.S. Patents and International Patents pending.

U.S. Government Restricted Rights

Licensee agrees that this software and/or documentation is delivered as "commercial computer
software," a "commercial item," or as "restricted computer software," as those terms are defined
in DFARS 252.227, DFARS 252.211, FAR 2.101, OR FAR 52.227, (or any successor provisions
thereto), whichever is applicable. The use, duplication, and disclosure of the software and/or
documentation shall be subject to the terms and conditions set forth in the applicable Rational
Software Corporation license agreement as provided in DFARS 227.7202, subsection (c) of FAR
52.227-19, or FAR 52.227-14, (or any successor provisions thereto), whichever is applicable.

Warranty Disclaimer

This document and its associated software may be used as stated in the underlying license
agreement. Except as explicitly stated otherwise in such license agreement, and except to
the extent prohibited or limited by law from jurisdiction to jurisdiction, Rational Software
Corporation expressly disclaims all other warranties, express or implied, with respect to
the media and software product and its documentation, including without limitation, the
warranties of merchantability, non-infringement, title or fitness for a particular purpose or
arising from a course of dealing, usage or trade practice, and any warranty against interference
with Licensee’s quiet enjoyment of the product.



Third Party Notices, Code, Licenses, and Acknowledgements

Portions Copyright ©1992-1999, Summit Software Company. All rights reserved.

Microsoft, the Microsoft logo, Active Accessibility, Active Client, Active Desktop, Active
Directory, ActiveMovie, Active Platform, ActiveStore, ActiveSync, ActiveX, Ask Maxwell,
Authenticode, AutoSum, BackOffice, the BackOffice logo, bCentral, BizTalk, Bookshelf,
ClearType, CodeView, DataTips, Developer Studio, Direct3D, DirectAnimation, DirectDraw,
DirectInput, DirectX, DirectXJ, DoubleSpace, DriveSpace, FrontPage, Funstone, Genuine
Microsoft Products logo, IntelliEye, the IntelliEye logo, IntelliMirror, IntelliSense, J/Direct,
JScript, LineShare, Liquid Motion, Mapbase, MapManager, MapPoint, MapVision, Microsoft
Agent logo, the Microsoft eMbedded Visual Tools logo, the Microsoft Internet Explorer logo,
the Microsoft Office Compatible logo, Microsoft Press, the Microsoft Press logo, Microsoft
QuickBasic, MS-DOS, MSDN, NetMeeting, NetShow, the Office logo, Outlook, PhotoDraw,
PivotChart, PivotTable, PowerPoint, QuickAssembler, QuickShelf, RelayOne, Rushmore,
SharePoint, SourceSafe, TipWizard, V-Chat, VideoFlash, Visual Basic, the Visual Basic logo,
Visual C++, Visual C#, Visual FoxPro, Visual InterDev, Visual J++, Visual SourceSafe, Visual
Studio, the Visual Studio logo, Vizact, WebBot, WebPIP, Win32, Win32s, Win64, Windows, the
Windows CE logo, the Windows logo, Windows NT, the Windows Start logo, and XENIX, are
either trademarks or registered trademarks of Microsoft Corporation in the United States
and/or in other countries.

Sun, Sun Microsystems, the Sun Logo, Ultra, AnswerBook 2, medialib, OpenBoot, Solaris, Java,
Java 3D, ShowMe TV, SunForum, SunVTS, SunFDDI, StarOffice, and SunPCi, among others, are
trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

Purify is licensed under Sun Microsystems, Inc., U.S. Patent No. 5,404,499.

Licensee shall not incorporate any GLOBEtrotter software (FLEXlm libraries and utilities) into
any product or application the primary purpose of which is software license management.

BasicScript is a registered trademark of Summit Software, Inc.

Design Patterns: Elements of Reusable Object-Oriented Software, by Erich Gamma, Richard
Helm, Ralph Johnson and John Vlissides. Copyright © 1995 by Addison-Wesley Publishing
Company, Inc. All rights reserved.

Copyright ©1997 OpenLink Software, Inc. All rights reserved.

This software and documentation is based in part on BSD Networking Software Release 2,
licensed from the Regents of the University of California. We acknowledge the role of the
Computer Systems Research Group and the Electrical Engineering and Computer Sciences
Department of the University of California at Berkeley and the Other Contributors in its
development.

This product includes software developed by Greg Stein <gstein@lyra.org> for use in the
mod_dav module for Apache (http://www.webdav.org/mod_dav/).

Additional legal notices are described in the legal_information.html file that is included in
your Rational software installation.



Contents

Product Definition.. ....... ....... ....... ....... ....... ...... ....... ....... ........... 1

What’s New in ClearCase LT..... .... .... ... .... .... .... ... .... .... .... ... ........ 3
New Features.. .... .... ..... .... ..... .... .... ..... .... ..... .... .... ..... .... ..... .... .... ......... 3

ClearCase LT Web...... .... ....... .... .... ....... .... .... ....... .... .... ........... ........ 3
New and Enhanced Integrations.... .......... .. ....... .. ....... . . . ....... . ........ . ..... 4

VS.NET... ..... ..... ..... ..... ..... ..... ..... ..... ..... ..... ..... ..... ..... ..... ......... 4
Visual Age for Java....... ...... ....... ...... ...... . ..... ...... . ...... ...... ...... ..... 5
WebSphere Studio.. ....... ....... ....... ....... ....... ....... ....... ....... ........... 5
Sybase PowerBuilder Enhancements... ..... ..... .... . .... ..... ..... ..... ......... 5
Forte for Java..... ..... ..... . .... . .... ..... . .... . .... ..... ..... . .... . .... . ..... ......... 5
JBuilder.. ..... .... ..... ..... ..... .... . .... ..... ..... .... ..... ..... .... ..... ..... ......... 5
Microsoft Office... ....... ....... .......... ....... ....... ....... ....... ....... ........... 5
UCM-ClearQuest Integration.................. ................ ................ ....... 5
Base ClearCase-ClearQuest Integration................................ .. . .. ..... 6

UCM Enhancements... ....... ....... ....... ....... . ...... . ...... ....... ....... . ...... ..... 6
Miscellaneous Enhancements.... .... .... ..... .... .... ..... .... .... ..... .... .... ......... 8

Announcements..... .... ..... .... ..... .... . .... ..... .... ..... .... ..... .... . .... ..... .... ......... 9
Status of the Feature Level..... ....... .... ....... .... ....... .... ....... .... ....... ........ 9
Distribution of Perl Extension..... ....... ........ . ...... . ...... . ...... . ...... . . ...... ..... 10
Perl Software Distributions in This Release..... ....... ....... . ..... .. ..... . ...... ..... 11
UCM-ClearQuest Integration Support for UCM Packages..... ....... ....... ........ 13
Miscellaneous Announcements........ ......... . . ....... . . ...... . . ....... . ........ . ..... 13

New Install.. ................ ................... ................... ................ ....... 13
Change in Installation Directory.. ...... ..... ..... ..... ..... ..... . .... . .... . ......... 13
Separate sitedef Files for Servers and Clients....... ...................... ....... 13
CLEARCASE_OBSO_SYN Not Supported........ ...... ....... . ..... . ...... ..... 14
Removal of the Term “atria”. ..... ...... ...... ...... ..... . ..... ...... . ..... ...... ..... 14
Name of Microsoft Word Integration dll changed..... .......... ....... ........... 14
Available Versions of ClearCase LT–ClearQuest Integrations.. .... .... ....... 14
Browser Support for ClearCase LT Web Interface................... . . .. . .. ..... 14

Changes to the Commands....... ..... ..... ..... ..... . ..... ..... ..... ..... ..... . .... . .... ..... 14
New Commands........ ............. ............. ............. ............. ................. 14
New Options and Arguments.. ......... ......... . . ....... . . ...... . . ....... . ........ . ..... 14
Obsolete Commands.......... .... .... .... .... .... .... .... .... .... ......... .... .... ........ 17
Obsolete Options and Arguments.... ....... ....... .......... ....... .......... ........... 17
Changes to Command Output.... .... ..... .... .... ..... .... .... ..... .... .... ............. 17
Changed Commands...... ....... .... ....... ....... ....... .... ....... ....... .... ........... 17

v



Changes to the Documentation.... ......................... ............................ ....... 18
HTML Help...... ..... ..... ..... ..... ..... .... ..... ..... ..... ..... .... . .... ..... ..... ......... 18
Command Reference...... .......... ....... .......... ....... .......... ....... .............. 18
Administrator’s Guide........ .................................................. ............. 18
Tutorial... ..... ..... ...... ..... ...... ..... ..... . ..... ..... ..... ...... ..... ...... ..... ..... ..... 18
Managing Software Projects..... ...... ...... . ..... ..... . ..... . ..... . ..... ..... ...... ..... 18
Location of Files... .... ........... .... .... .... .... .... .... ........... .... .... .... .... ........ 18

Restrictions and Guidelines for Using ClearCase LT..... .... ..... ........ 19
Copyright Information... ................... ...................... ......................... ....... 19
Install-Related Restrictions..... .... .... .... .... .... .... .... .... .... .... .... .... .... .... ........ 19

Installer Incompatible with Windows Change Journal Feature.. .. ... .. .. .. .. ...... 19
ClearCase LT Web............ .... .... .... .... .... .... .... ........... .... .... .... .... .... ........ 19

Netscape Versions for ClearCase LT Web and Other Rational Suite
Products... ..... ..... ..... ..... ..... ..... ..... .... ..... ..... ..... ..... ..... ......... 20

Comparing Unicode Files Across Multilanguage Platforms........ ................. 20
Load Rule Scopes.... ....... ...... ....... . ..... . ..... . ...... . ..... . ...... . ..... . ...... ..... 20
Compare/Merge Operations Limited to text_file Elements... ..... ..... .... . . . ...... 20
Using Special Characters on Non-ASCII Operating Systems... ............. ....... 20
Setting Permissions for Temporary File Directory. ..... ...... ..... ..... ..... . .... ..... 21
Relationship Between Pathnames and Hyperlinks....... ....... .... ....... ........... 21
Platform Recommendations for Best Performance.............................. ..... 21
Handling SSL Warnings............................ ........................................ 21
Web Client Can Be Very Slow When Browsing Large Directories.. .. .. ... .. ...... 22
Browser Pop-up Windows.... ..... ...... . ..... ..... . ..... . ..... ..... . ..... ...... ..... ..... 22

ClearCase LT-ClearQuest Integration...... ...... ..... . ..... . ..... ..... . ..... ...... ..... ..... 22
Activity Link with ClearQuest Record (UCM-ClearQuest Integration).. . . .. . . ..... 22
Registry Problem (Base ClearCase LT–ClearQuest Integration)...... ........ ..... 23
Permissions Problem (Base ClearCase LT–ClearQuest Integration).. ............ 23
Naming dbsets (UCM-ClearQuest Integration)....... ............. . . .. ........ .. . ..... 24

Use of Rootless UCM Components... .............................................. .......... 24
Treatment of Workaround for RATLC00586383 at This Release....... ......... .. . ..... 25
Treatment of Time Stamps by Windows and UNIX.................................. . ..... 25
Adding a Large Number of Files from Windows Explorer....... .... ....... ....... ........ 25
MMC taskpads and the Admin Console............................. ......................... 25
Checking In Identical .frm Files in Visual Basic 6.0... ...... ....... ...... . ..... . ...... ..... 26
Displaying Logging Text Inside IDE... ..... ..... ..... . .... . ..... ..... ..... ..... ..... . .... ..... 26
Problems with the Documentation...... ........ ........ .. ...... . ....... . ....... . ....... . ..... 26

Browsing the Documentation with Netscape Navigator........... .... ........ . . ..... 26
Omissions from the Command Reference................................. ............. 26
Omission from the Administrator’s Guide.... .... .... .... .... ........... .... .... ........ 27
Omission from Managing Software Projects......... ......... . . . ....... . . ....... . ..... 27

vi Release Notes



Status of ClearCase LT Software Change Requests.... .... ... .... ........ 29

Contacting Rational Technical Support..................... ................... 31

Contents vii



viii Release Notes



Tables

Table 1 Feature Levels and ClearCase LT Versions..... ..... ..... ..... ..... ......... 10
Table 2 Modifications to 5.6.1 Perl Distribution... ..... ...... ..... . ..... ..... ..... ..... 11
Table 3 Modifications to 5.001m Perl Distribution... .... .... ..... .... .... ..... ........ 11
Table 4 New Options and Arguments.. ....... ........ . ...... . ...... . ...... . . ...... ..... 15

ix



x Release Notes



Scope

These release notes present information about the definition, delivery, and operation
of Rational ClearCase LT configuration management software.

xi



xi Release Notes



Product Definition 1

Rational ClearCase LT software for Windows operating systems offers client/server
solutions for configuration management software. ClearCase LT server software
must be installed on a host in the same network domain as the hosts on which you
install ClearCase LT client software. A client can access only one server at a time.
To ensure adequate performance for all clients, we recommend that you install the
ClearCase LT server on a dedicated host.

Before you install ClearCase LT software, read the Release Notes for Rational Suite, the
Installation Guide for Rational Server Products and the Installation Guide for Rational
Desktop Products (distributed with your software).
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What’s New in
ClearCase LT 2

This chapter describes new features and other changes in Version 2003.06.00 of
Rational ClearCase LT, as follows:

� New Features

� Announcements

� Changes to the Commands

� Changes to the Documentation

New Features

The following is a summary of the new features that are introduced in this release of
ClearCase LT:

� ClearCase LT Web

� New and Enhanced Integrations

� UCM Enhancements

� Miscellaneous Enhancements

ClearCase LT Web

ClearCase LT Web supports the following new features:

� The Rational Web Platform (RWP) is the new server for the Web interface.
ClearCase LT is a CGI executable that runs with the Apache Web server provided
by RWP. We no longer support any other Web server as the server for this interface.
For more information, see the Administrator’s Guide.

� Support for Mozilla 1.0–based browsers, including Mozilla 1.0 and Netscape 7 .

� Reverse proxy support. The Web interface allows requests from external users to
be passed through a firewall to an internal ClearCase LT Web server.

� Performance improvement. When you perform an update, load, or restore
operation on a large number of files, the associated Progress page displays either a
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Show Details or Hide Details button. Hiding the details can improve performance
dramatically when several thousand or more file elements are the subjects of
the operation.

� You can create a UCM view based on an existing development stream, even if you
are not the owner of the stream, as long as you are a member of the same group.

� Support for multibyte character sets.

� Support for Sun JVM 1.4.

� Full-text search capabilities in Help through the Search tab in the left navigation
pane.

� Using Compare (in ClearCase Properties), you can compare the current version of
an element with any other version. In previous releases, you could compare a
version only with its predecessor.

For complete information, see the Help.

New and Enhanced Integrations

This section describes integrations that are new or enhanced in this release.

VS.NET

ClearCase LT is integrated more fully with Microsoft VS.NET than with its predecessor
product, Visual Studio. This integration supports the UCM and base ClearCase
process models, with and without Rational ClearQuest.

The ClearCase LT-ClearQuest integration is also available in VS.NET. You can use
these products separately or link them through UCM. With the UCM configuration,
you can work on activities and manage change requests concurrently within the
VS.NET IDE.2.

Highlights of the integration include the following:

� Whether you are working in UCM or Base ClearCase, the toolbar displays only the
operations that are relevant to the process you use.

� A Front Desk utility retains a list of the most recently used views or activities
associated with the VS.NET project.

� The integration includes context sensitive menus from within the VS.NET Solution
Explorer.

For more information, see the Help for CC.NET.

4 Release Notes



Visual Age for Java

This release provides support for the integration of ClearCase LT with Visual Age for
Java 3.5.3. To configure the integration, see the Help.

WebSphere Studio

This release introduces the integration of ClearCase LT with WebSphere Studio. The
integration supports WebSphere Studio versions 4 and 5.0 running on versions 1.0,
2.0, and 2.1 of the Eclipse shell. For more information, see the Help.

Sybase PowerBuilder Enhancements

This release adds support for PowerBuilder 8.0. The integration has also been
enhanced to make the application path persist across sessions. For more information,
see the Help.

Forte for Java

This release introduces the integration of ClearCase LT with Forte for Java version
3.0. For more information, see the Help.

JBuilder

This release provides support for Borland JBuilder versions 5, 6, and 7. For more
information, see the Help.

Microsoft Office

This release provides support for Microsoft Office 2000 and XP.

UCM-ClearQuest Integration

This release includes the following enhancements to the UCM-ClearQuest integration:

� CAL API Calls. Seven calls have been added to the ClearCase Automation
Library (CAL) API for administrators who want to customize the behavior of the
integration. These calls return information about UCM objects in a project enabled
for ClearQuest. Administrators can include the CAL calls in ClearQuest hook
scripts to enforce development policies. For more information, see the Help.

� Performance enhancement. This release incorporates changes that reduce the
communications overhead between ClearCase LT and ClearQuest.

� During a deliver operation in a project enabled for ClearQuest that has set the
policy Transition to Complete After Delivery, if any of the activities being delivered
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is set to a view, the integration unsets the activity from that view after it transitions
the activity to a Complete type state. For more information, see Managing Software
Projects.

� Format options implemented for this integration enable you to determine
the view set to the UCM activity (%[view]p), the ClearQuest record type
(%[crm_record_type]p), the likeliest view for resolving the names of versions in a
change set (%[name_resolver_view]p), and the name of the ClearQuest database
(%[crm_database]p). See the fmt_ccase reference page.

� New policies provide more flexibility in controlling the behavior of projects
enabled for ClearQuest. For more information, see Managing Software Projects
and the Help.

Base ClearCase-ClearQuest Integration
� This integration supports the association of multiple file imports (by clearfsimport)

with a single change request. For more information, see the clearfsimport
reference page.

� Enhanced capabilities for making ClearQuest associations. The integration lets
you specify a file’s association with a defect or defects by using checkout or
checkin comments that contain a text pattern specified in the environment variable
CQCC_COMMENT_PATTERN, or obtain a list of files to associate with a defect from
the environment variable CQCC_AUTO_ASSOCIATE. For more information, see the
file ccase-home-dir\lib\perl5\CQCCTrigger\CQCC\README.

UCM Enhancements

This release includes the following enhancements to UCM:

� Single-stream projects. Customers who prefer a serial, rather than a parallel,
development environment can use single-stream projects. A single-stream
project contains one stream: the integration stream. Developers join the project
by creating an integration view attached to the integration stream. Because
developers work directly on the integration stream, they do not perform deliver or
rebase operations. We recommend single-stream projects only for small teams of
developers who work closely together.

� Read-only streams. You can designate specific streams as read-only to prevent
developers from making changes to the stream’s components. For example, you
might create a read-only stream for your release engineering team members so
that they can access a set of baselines without inadvertently making changes to
components.

� Baseline naming templates. Project managers can specify a template to be used
in naming baselines within a project. They construct a baseline naming template
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by choosing tokens that represent variables such as project name, component
name, date, and so on.

� Performance enhancements. This release incorporates changes that reduce the
processing and communications overhead for almost all UCM operations.

� Format options for object properties. Formatting options for UCM
object properties enable you to output the initial baseline of a component
(%[initial_bl]Xp), the activities of a baseline (%[activities]Xp), the promotion level
of a baseline (%[plevel]p), the promotion levels defined in the PVOB (%[plevels]),
and whether or not a stream is read-only (%[read_only]p). See the fmt_ccase
reference page.

� Delivering the current activity. The –cactivity option for deliver specifies that the
currently set activity is to be delivered. See the deliver reference page.

� Determining baseline membership. The lsbl command supports the options
–member_of and –recurse, which enable you to determine whether a baseline is a
member of a composite baseline. See the reference pages for lsbl and fmt_ccase.

� Displaying the activities of a delivery. In the Compare Baselines GUI, you can
right-click a deliver integration activity on the Activities tab and select Show
Contributing Activities from the shortcut menu to show the contributing activities
that were included in the deliver operation.

For integration activities in projects enabled for ClearQuest, you can click Actions
> Contributors on the ClearQuest record form to display the activities that were
included in the deliver operation.

� Using lsproject to display ClearQuest policies. The lsproject –l command
displays ClearQuest policies for a project that is enabled for ClearQuest. For more
information, see the lsproject reference page.

� 1024–byte object names. Thecleartool interface supports object names of up
to 1024 bytes in length (Windows imposes a limit of 260 bytes). Although this
enhancement is not specific to UCM, it is of particular interest to UCM users,
who must contend with long, generated object names. Note that the GUIs do
not support 1024–byte object names. For information on object naming, see the
cleartool refernce page.

� Checking PVOB/component relationships. The checkvob command incorporates
functionality for detecting and repairing relationships among a PVOB, a project’s
components, and for projects that are enabled for ClearQuest, the ClearQuest user
database. For more information, see the Administrator’s Guide and the checkvob
reference page.

� Listing activities by user. You can use the lsactivity command to list only those
activities that are owned by a specified user. See the lsactivity reference page.
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� Checking in all versions in an activity’s change set. In the Project Explorer, you
can right-click an activity and select Checkin All from the shortcut menu to check in
all versions in the activity’s change set. In projects that are enabled for ClearQuest,
you can click Finish Activity from an activity’s shortcut menu. This checks in all
versions and performs ClearQuest actions, such as transitioning the activity to a
Complete type state, based on the project policies that were set.

� New Events. There are new events that support UCM operations. See the
events_ccase reference page.

� Changes to VOB Creation Wizard and Project Explorer. These GUIs support the
creation of multiple components that are stored in the same VOB.

For more information, see Managing Software Projects, the reference pages cited in
this section, and the Help.

Miscellaneous Enhancements

This section describes miscellaneous enhancements in this release.

� Uncataloging elements that have checkouts. By default, the rmname operation
behaves correctly by failing when the element specified to be uncataloged is
checked out. See the rmname reference page.

� Creating elements in view-private directories. The mkelem command supports a
–mkpath option that creates an element from a view-private file or directory that
resides in a view-private directory. The distinctive behavior of this option is that it
also creates elements from all view-private directories in the element path. See
the mkelem reference page.

� Handling white space during merges. In previous releases, you could ignore
white space when using cleardiff by means of the –blank_ignore command-line
option or the Ignore white space during merge option in the Diff Merge Properties
window. However, in graphical mode the option was supported only for
comparisons, not merges. At this release, the Ignore white space option is available
during a merge. In addition, the command option –favor_contrib enables you to
specify a contributor to be used for white space formatting of unchanged lines.
For graphical merges, the cleardiff GUI displays a list of contributors (Take white
space changes from:) from which you can select one to be used for white-space
formatting. See the Help and the reference page for cleardiff.

� CLEARCASE_GROUPS environment variable. The environment variable,
CLEARCASE_GROUPS, can be used to specify a list of up to 32 groups that
ClearCase considers first when determining or displaying which groups a user
belongs to. For more information, see the Administrator’s Guide and the env_ccase
reference page.
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� Printing differences in contributors. The Diff Merge GUI now allows you to print
the differences in contributors and includes options to control the layout. See the
Help for details.

� Manual merges for graphical rebase operations. The Rebase Stream Preview
dialog box incorporates a new option, Merge elements graphically. This option
disables automatic merges, allowing you to merge element versions graphically,
even if there are no conflicts. See the Help for details.

� XDE and Rose element types. This release introduces the element types xde (for
Rational XDE) and rosert (for Rational Rose RealTime). For more information,
see the type_manager reference page.

� Type managers for XDE Tester. This release introduces the XDE Tester type
managers _rftdef, _rtfmap, and _rftvp. These type managers are versions of the
binary_delta type manager.

� New.Net detection by CC Doctor. The New.Net third-party plug-in software is
known to have compatibility problems with ClearCase LT. CC Doctor now detects
and reports the presence of this software.

� Object name restriction relaxed. The restriction on object names that disallowed
numerics values has been relaxed such that only integers are disallowed. The data
converters—the commands that are prefixed clearexport_–have been modified
to take advantage of this change. For information about object naming rules, see
the cleartool reference page.

Announcements

This section contains announcements, as follows:

� Status of the Feature Level

� Distribution of Perl Extension

� Perl Software Distributions in This Release

� UCM-ClearQuest Integration Support for UCM Packages

� Miscellaneous Announcements

Status of the Feature Level

This release introduces feature level 4. Table 1 shows all supported feature levels and
the versions at which they were introduced.
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Table 1 Feature Levels and ClearCase LT Versions

Feature level Introduced in version

2 4.0

3 2002.05.00

4 2003.06.00

Feature level 3 placed constraints on client/server compatibility in UCM
environments. Feature level 4 introduces no additional constraint; it is equivalent to
feature level 3 in terms of PVOB client/server compatibility. For information on
feature level 3, see the Version 2002.05.00 Release Notes for your product. Also note
that read-only streams and single-stream projects are restricted to PVOBs at feature
levels 3 and higher (see the reference page for mkstream).

Raising the feature level to 4 results in the following changes in the VOB:

� The predefined element types xml, html, and rose (if they exist) are renamed to
xml_v5.0, html_v5.0, and rose_v5.0, respectively. Similarly, element type names
that you have changed are renamed to name_v5.0. The v5.0 types lose their status
as well-known element types. Accordingly, when you create new elements, the
file-to-type mapping mechanism no longer treats these types as the defaults (see
the cc.magic reference page). The type of an existing element does not change;
however, you can use chtype to change it.

� The new predefined element types xml, html, and rose are created. The purpose
of replacing these types is to base the type managers on the binary_delta type
manager instead of the text_file_delta manager. The cc.magic file maps new
elements to these types by default.

� The element type xde is created.

For instructions about raising the feature level of a VOB, see the chflevel reference
page.

Distribution of Perl Extension

ClearCase::CtCmd is a Perl extension that takes cleartool–like arguments.
ClearCase::CtCmd takes a string or an array as an input argument and returns a
three-element Perl array, as follows: a status bit, a scalar string corresponding to
stdout, and any error message corresponding to stderr. This Perl extension and its
documentation are available from www.cpan.org.

Note: After upgrading to Version 2003.06.00, you must rebuild ClearCase::CtCmd
to account for the addition of new libraries and symbols to ClearCase LT
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Perl Software Distributions in This Release

Beginning with this release, Perl 5.6.1 is distributed with ClearCase LT. Perl 4 has
been removed from this release. For backward compatibility, this release also
includes a modified version of Perl 5.001m. To use 5.001m instead of Perl 5.6.1, set
CCASE_USEPERL5 to a nonempty string (see the env_ccase reference page). To verify
the version that is being invoked, type ccperl –ver.

In conformance with the Artistic License Agreement under the terms of which Perl is
distributed,Table 2 describes the modifications that were made to Perl 5.6.1.

Table 2 Modifications to 5.6.1 Perl Distribution

Reason for modification

Modification Source file modified

Changes to accommodate Rational installation structure

Customize install path win32/config.vc, win32/cinfig.bc,
win32/config.gc

Customize @INC win32/win32.c

Use Rational naming conventions

Specify ratperl in .def makedef.pl

Use “ratl” name and Rational install path win32/Makefile, win32/config.bc

Likewise, in conformance with the Artistic License Agreement Table 3 describes the
modifications that were made to Perl 5.001m.

Table 3 Modifications to 5.001m Perl Distribution

Reason for modification

Modification Source file modified

Accommodation of underlying C library changes or other OS changes

Use tempnam instead of mktemp perlexe.cpp

Building with DLL version of C library perl.h

Use open_osfhandle, so we don’t need to rely on
libc

perlexe.cpp

Changes to accommodate Rational installation structure

Have NtGetSiteLib use CLEARCASE_HOME ntxs.cpp

Use Rational naming conventions
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Table 3 Modifications to 5.001m Perl Distribution (Continued)

Reason for modification

Modification Source file modified

perl.exe, perlglob.exe become ccperl.exe,
ccperlglob.exe

pp_hot.cpp

New functions and other changes needed by the embedded ClearGuide interpreter

PerlRequire, PerlClearAv, PerlPushAv,
PerlUnshiftAv, PerlCreateSv

perllib.cpp, perlexe.cpp, perllib.h

Changes related to ClearGuide modules

Fix for load_process_family_source Getopt/Long.pm

Inclusion of changes/upgrades from public domain to sources

5.002 PerlEval perllib.cpp

Defect fixes independent of public domain

Fix of crash in catch in PerlRequire perllib.cpp

Not getting $@ or return value perllib.cpp

Change in build or test environment to Perl modules as shipped

Fix autoloading ParseWords.pm

Version related changes

Remove v5.004 test HTML.pm, Entities.pm

Remove use strict for use by Perl 5.001m HTML.pm, Parser.pm

Remove use strict for use by Perl 5.001m Date.pm, Parse.pm

Changes to NT modules

Incorporate Net::SMTP Mail.pm, Mailer.pm

Make it work with NT Perl 5.001m Net.pm, SMTP.pm

Make it work with NT Perl 5.001m Time.pm, Zone.pm

This release is the last major release that includes 5.001m. The unmodified
sources for Perl versions 5.001m and 5.61, as well as the binaries built from
them, are archived at ftp.rational.com. A link to the archive can be found at
www.rational.com/support/downloadcenter/index.jsp.
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UCM-ClearQuest Integration Support for UCM Packages

In the Project Properties and New Project Wizard GUIs, the ClearQuest page displays
the policies that are appropriate for the UCM level of the ClearQuest user database
associated with the project. If the ClearQuest user database uses the revision 5.0
UCM package (corresponding to Version 2003.06.00), the available policies are as
documented in the Help and in Managing Software Projects.

If the ClearQuest user database uses an earlier UCM package, the available policies
are as follows:

� For UCM package revision 2.0:

� Check assignment before WorkOn

� Check before ClearCase delivery

� Do ClearQuest action after delivery

� For UCM package revisions 3.0 and 4.0:

� Check assignment before WorkOn

� Check before ClearCase delivery

� Do ClearQuest action after delivery

Miscellaneous Announcements

This section contains miscellaneous announcements about this release.

New Install

The install program is new; for complete information, see the Installation Guide.

Change in Installation Directory

In previous releases, the name of the installation destination directory that you
specified included the name of the product, “ClearCase.” In this release, you should
specify only the name of the directory in which the ClearCaseClearCase LT directory
is to be created. The standard location for this directory is drive\Program Files\Rational.
If you specify ClearCase in this path, the product is installed in drive\Program

Files\Rational\ClearCase\ClearCase.

Separate sitedef Files for Servers and Clients

In previous releases, one sitedef file held default values for both servers and clients. In
this release, you create separate sitedef files for servers and clients.
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CLEARCASE_OBSO_SYN Not Supported

The environment variable, CLEARCASE_OBSO_SYN, is not supported in this release.

Removal of the Term “atria”

The following change was made to remove the term "atria":

� The environment variable ATRIAHOME has been renamed CLEARCASEHOME.

Name of Microsoft Word Integration dll changed

The name of the dll install file has been changed from CCWordIntegration.dll to
ccmsoaddin.dll, and the integration has been expanded to include Microsoft Excel
and PowerPoint.

Available Versions of ClearCase LT–ClearQuest Integrations

The ClearQuest Configuration tool (cqconfig) offers the administrator a choice of
the V1 (previous) integration or the V2 (new) integration implementation allowing
administrators to migrate to the new integration as appropriate. The default values
were set to V2 on UNIX (because V2 was a superset of the V1 implementation) and
to V1 on Windows (because the V1 integration had a GUI interface that V2 initially
lacked). In this release, the V2 GUI is now available in all circumstances making it as
functionally complete as the V1 Windows integration. Accordingly, the default for
Windows is now set to V2. Administrators can still select V1.

Browser Support for ClearCase LT Web Interface

The Web interface no longer supports Netscape 4.7; use Netscape 7 instead.

The Web interface supports Internet Explorer Versions 5.5 and 6.0 running either the
Microsoft JVM or the Sun Microsystems JVM, Version 1.4.0 or later.

Changes to the Commands

This section describes changes to the ClearCase LT command set.

New Commands

This release introduces no new commands.

New Options and Arguments

Table 4 lists new options and arguments to commands.
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Table 4 New Options and Arguments

Command New option/argument Use

–view view-tag Transitions an activity in the specified
view.

chactivity

–cqaction { –cact |
activity-selector ... }

In a single-stream project, checks in the
versions in the change set of an activity
and closes the activity if the relevant
ClearQuest policies have been set.

–ucm Runs checkvob in UCM mode.

–view view-tag Uses the view specified in view-tag.

–log log-dir-pname Specifies an alternative directory for the
log file directory.

–fix [ –force ] Directs checkvob to try to correct any
problems it finds. Without –force, –fix
prompts you before fixing any problem
object.

–verbose Specifies verbose output.

–crm_only Examines only references to records in a
ClearQuest database

–vob_only Examines only references to objects in
components.

–component
component-selector

Further restricts a –vob_only check to the
component specified by component-selector

object-selector... Specifies the object types that are to be
checked.

–crm_dbname
user-database-name

Checks the references held in the
ClearQuest database specified by
user-database-name.

–activity cq-display-name Checks the references held by the activity
record specified in cq-display-name.

checkvob

–project cq-display-name Checks the references held by the project
record specified in cq-display-name.

chproject –blname_template
baseline-naming-template

Defines the baseline name template for a
project.
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Table 4 New Options and Arguments (Continued)

Command New option/argument Use

chstream –cview Specifies the stream connected to the
current view to be modified.

–reset –to integration-view-
tag

Resets a new integration view so you can
cancel, resume, or complete a deliver
operation after the integration view is lost
during a deliver operation.

deliver

–cactivity Specifies that the currently set activity is
to be delivered.

–tiny Same as –window, but uses a smaller font
in a 165-character difference window.

diff

–window Displays output in a separate difference
window.

diffbl –nmerge Specifies that no merge is to be performed.

-me Displays activities owned by the current
user.

lsactivity

–user user Displays activities owned by the specified
user.

lsbl -member_of [ –recurse ] Used by itself, displays the composite
baselines of which each baseline is a direct
member. Used with the -recurse option,
displays all baselines of which each
baseline is a direct or indirect member.

lsstream –in { project-selector |
stream-selector }

Displays a list of all streams for the
specified project, or a list of child streams
for the specified stream.

mkbl –view view-tag Specifies the view from which to create
baselines.

mkdir –master Assigns mastership of the main branch
of the directory element to the VOB
replica in which you execute the mkdir
command.
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Table 4 New Options and Arguments (Continued)

Command New option/argument Use

mkelem –mkpath For an element that is being created from
a view-private file or directory, this option
creates elements from its view-private
parent directories.

mkproject –model { SIMPLE |
DEFAULT }

Sets the project model. SIMPLE: A
single-stream project; DEFAULT: A
multiple-stream project.

mkstream –readonly Creates a read-only stream.

pro-
tectvob

pname-in-vob Pathname of the VOB tag or of any file
system object within the VOB.

Obsolete Commands

No commands are obsolete at this release.

Obsolete Options and Arguments

The dir argument to annotate and the –glossary option for apropos are obsolete.

Changes to Command Output

Significant changes to command output are as follows:

� The event comment for the rmname operation has been changed from Removed

file element to Uncataloged file element in order to reflect the nature of
the operation more accurately and distinguish it more clearly from the rmelem
operation.

� Output from the schedule command uses ISO dates regardless of any specified
date format preference.

Changed Commands

Commands that have changed in one or more respects are as follows: annotate,
apropos, chactivity, checkvob, chproject, chstream, deliver, describe, diff, diffbl,
find, lsactivity, lsbl, lsstream, lstype, man, mkbl, mkdir, mkelem, mkproject,
mkstream, protectvob, rebase, rmname, schedule. For details, see the corresponding
reference pages.
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Changes to the Documentation

This section describes noteworthy changes to the documentation.

HTML Help

Most Help, including reference pages, is HTML.

Command Reference

The following reference page has been removed from the Command Reference:

� The reference page for ClearCase::CtCmd has been removed; for information about
this Perl extension, see the Comprehensive Perl Archive Network (www.cpan.org).

Administrator’s Guide

The Administrator’s Guide contains new information about backing up and restoring
ClearCase LT and ClearQuest data together.

Tutorial

The script-driven tutorial has been replaced with an HTML tutorial without scripts.

Managing Software Projects

A platform-independent edition of Managing Software Projects replaces the separate
UNIX and Windows editions that were published at earlier releases.

Location of Files

Manuals in Portable Document Format (PDF) are installed in ccase-home-dir\doc\books.
In previous releases, they were installed in ccase-home-dir\bin.

Most Help files are installed in ccase-home-dir\doc\help. In previous releases, they were
installed in ccase-home-dir\bin.
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Restrictions and
Guidelines for Using
ClearCase LT

3

This section explains restrictions and guidelines affecting the use of Rational
ClearCase Version 2003.06.00 software that are considered noteworthy. These are
not necessarily considered defects because the behavior reported is not expected to
change in a future release of the product.

This section also describes significant problems with the documentation and includes
documentation that was inadvertantly omitted from the manuals or Help.

Copyright Information

In some cases, you will not be able to view the Rational copyright information online.
If you want to see this information, you can find it on the Rational Solutions for
Windows product CD, Disk 1 under doc/legal_information.html.

Install-Related Restrictions

This section describes restrictions related to the installation of ClearCase LT.

Installer Incompatible with Windows Change Journal Feature

File system corruption can sometimes result from installing ClearCase LT on Windows
2000 to an NTFS partition that has the Windows Change Journal log enabled on it. We
are working with Microsoft to fix the problem.

Before installing ClearCase LT onto a Windows 2000 system, read Rational Solution
182435434 at http://solutions.rational.com/solutions/display.jsp?solutionId=182435434.
Alternatively, you can search for the text change journal in the Rational Solutions
Knowledge Base at http://solutions.rational.com/solutions.

ClearCase LT Web

This section describes limitations on and guidelines for using the ClearCase LT Web
product.
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Netscape Versions for ClearCase LT Web and Other Rational Suite
Products

The ClearCase LT Web product requires Netscape 7. However, the rest of the Rational
Suite products require Netscape 4.78, and are not guaranteed to work correctly on
Netscape 7. If you use ClearCase LT Web and another Rational Suite product, use
Netscape 7 as your ClearCase LT Web browser, but do not modify your PATH.

Comparing Unicode Files Across Multilanguage Platforms

For a Unicode file to be processed correctly when using the compare operation across
multilanguage platforms, the file needs a byte-order mark, as follows:

File encoding Byte-order mark

UTF-8 EF BB BF

UTF-16/UCS-2, Little Endian FE FF

UTF-16, UCS-2, Big Endian FF FE

UTF-32/UCS-4, Little Endian FF FE 00 00

UTF-32/UCS-4, Big Endian 00 00 FE FF

Load Rule Scopes

For the Web interface, snapshot view config spec load rules are specified differently
from the way they are specified for the native interface. The keyword load is not
needed in the Load rule scopes portion of the config spec for the Web client.

Compare/Merge Operations Limited to text_file Elements

The Compare and Merge operations are limited to elements of type text_file. Attempts
to perform these operations on other types will fail.

Using Special Characters on Non-ASCII Operating Systems

Using special characters on non-ASCII operating systems can cause server output
to be corrupted or the server to crash.

For example, the Shift-JIS double-byte tilde character (FULLWIDTH TILDE), which
is used to indicate “Copy of” in the Japanese Windows environment, can cause this
problem. The problem originates in differences between the Unicode conversion
tables used by ICU (the publicly available Unicode software currently used by the
Web interface) and the base operating system. The ICU Shift-JIS conversion table
maps FULLWIDTH TILDE to WAVE DASH.
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Setting Permissions for Temporary File Directory

The server-side CGI process needs access to a directory in which it can create
temporary files. The default on Windows is c:\. If the permissions on this
directory do not allow everybody to create files in it, obscure failures occur,
often with the error message, Operation "fileutl_tmpfile_ext_binary"

failed: Permission denied. To avoid this problem, create a directory on
the server with permssions that are set to allow everybody access to create files
there. Then add a directive like the following to the RWP configuration file:
SetEnv TMP d:\temp. The RWP configuration file is normally stored at c:\Program

Files\Rational\common\rwp\conf\rwp.conf.

Relationship Between Pathnames and Hyperlinks

Pathnames that refer to files in your Web view are normally presented as hyperlinks.
However, the Netscape 7 and Mozilla browsers enforce more stringent security
restrictions than do other browsers. In these browsers, pathnames are not presented
as hyperlinks because they cannot be traversed.

Platform Recommendations for Best Performance

For best performance, we recommend running the Web interface on Windows 2000,
Windows XP, or Windows NT.

Handling SSL Warnings

When running the Web interface under SSL, the browser displays warning messages
such as You are leaving a secure site. For example, in the VOB View, this may
happen when you click a file name to view the file. The reason for the warning
message is that a new window is launched to view the local file under the file protocol
rather than under https. However, if you choose to view the same file by clicking View
on the Properties page, a new window is launched under https, returning to the
server, and the warning message does not appear.

You can safely ignore these warning messages because all client-server
communications in the Web interface are encrypted. To disable the warning messages,
use one of the following procedures:

On Mozilla and Netscape 7

1 Click Edit > Preferences > Privacy & Security > SSL.

2 In the SSL Warnings section of the SSL page, clear all check boxes.

On Internet Explorer
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1 Click Tools > Internet Options.

2 On the Internet Options page, click the Advanced tab.

3 In the Security section, clear the check box that is labeled Warn if changing between
secure and not secure mode.

Note that when running Internet Explorer 6 on Windows XP, you cannot disable
these warning messages when the displayed page has content from both secure and
insecure sources.

Web Client Can Be Very Slow When Browsing Large Directories

The Rational ClearCase LT Web client can be very slow when browsing large
directories, especially when your client PC has a slow CPU or limited RAM. For
example, on an 800 MHz PC with sufficient RAM, a 1500 entry directory can take
approximately 2 minutes to render.

To work around this situation, use one of the following workarounds:

� Smaller directories

� A client PC with a faster processor speed

� If you are running ClearCase LT Version 2003.06.00, a Mozilla based browser.
Mozilla based browsers seem to be faster than Microsoft Internet Explorer when
browsing large directories.

Browser Pop-up Windows

When using the ClearCase LT Web client, display of pop-up windows must be
enabled in your browser.

ClearCase LT-ClearQuest Integration

This section describes restrictions that affect the ClearCase LT–ClearQuest integration.

Activity Link with ClearQuest Record (UCM-ClearQuest Integration)

When a ClearCase activity in a project enabled for ClearQuest is linked to a
ClearQuest record, the Name of the ClearCase activity is set to match the ClearQuest
record’s ID. This allows you to access the corresponding activity when you are
working on a defect by using the current defect number. For example, you can use
the command, cleartool setactivity ClearQuest-record-ID.

We recommend that you do not change the name of a ClearCase activity, although
ClearCase does not prevent that. If you change an activity name, you cannot use the
setactivity command as already described.
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Note that the Headline field for a ClearCase activity is synchronized with the
corresponding field in a ClearQuest record. That is, if you change this field from
within either ClearCase or ClearQuest, the corresponding field in the ClearQuest
record or ClearCase activity is modified as well.

Registry Problem (Base ClearCase LT–ClearQuest Integration)

The original Windows version of the Base ClearCase-ClearQuest integration ("V1")
may on occasion fail to see the expected ClearQuest database because of outdated
or incorrect description information that is maintained in the Registry. The error
message that results is "Error trying to logon to the ClearQuest database"

If this occurs, do the following:

1 Using regedit, check the following registry entries and correct the information if
necessary, where version is the ClearQuest version, for example, 2003.06.00 and
user is the current user name.

HKEY_CURRENT_USER\Software\Rational Software\ClearQuest\2003.06.00\Common\CQIntSvr\marie

2 Using the Windows NT Task Manager or similar tool appropriate for your
operating system, locate and end the process cqintsvr11.exe. The process restarts
as needed and checks the registry for the latest values of the keys that were set
in Step 1.

Permissions Problem (Base ClearCase LT–ClearQuest Integration)

A problem that is believed to originate in a Microsoft service pack can cause the Base
ClearCase LT–ClearQuest integration to fail when a user logs on to a computer with
an identity other than Administrator. The symptoms may include error messages
such as This program can only be run within a ClearQuest trigger or
Automation error...library not registered. To repair the problem:

On Windows 2000 and Windows XP systems

1 Log on to the system as Administrator.

2 Edit the registry using the regedt23 command, select HKEY_CLASSES_ROOT, scroll
down to TypeLib, and click it.

3 Select Security > Permissions from the main menu.

4 In the dialog box, add an entry for Everyone if this entry has not already been
established.

5 Enable Allow read access for this entry.
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6 Click Advanced, select Reset Permissions on all child objects, and enable
propagation of inheritable permissions.

7 Click Apply and confirm the changes.

On Windows NT 4.0 systems

1 Complete steps 1 through 5 of the procedure for Windows 2000 and Windows
XP systems.

2 Select Replace Permission on Existing Subkeys.

3 Click OK and confirm the changes.

Naming dbsets (UCM-ClearQuest Integration)

When assigning names to dbsets, follow these rules:

� If you have only one dbset, you can name it as you want.

� If you have multiple dbsets, the dbset that is to be associated with the integration
should, if possible, be named the ClearQuest version that you are using; for
example, 2003.06.00.

� If you have multiple dbsets and none of them can be assigned the name of the
ClearQuest version string, use the procedure that follows for naming the dbset
that is to be associated with the integration.

1 Stop the clients.

2 Start the Windows registry editor.

3 Navigate to HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion.

4 Click CurrentVersion, click Edit > New > Key, and type ClearCase Squid.
You should now have the new registry key, HKEY_LOCAL_MACHINE\Soft-

ware\Atria\ClearCase\CurrentVersion\ClearCase Squid.

5 Click ClearCase Squid, click Edit > New > String Value, and type DBSet in the Value
Name field of the Edit String properties sheet.

6 Type the name of the master database in the Value Data field on the Edit String
properties sheet. You should now have a single string value named DBSet with
the database name as its data.

7 Restart the clients.

Use of Rootless UCM Components

It is no longer possible to make a baseline in a rootless component that is not
modifiable. Making a baseline of a composite component for the purpose of changing
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its members is regarded as making a modification in a component. A rootless
component should be modifiable except in the following circumstances:

� The component is to hold only non-modifiable members.

� No baseline is ever to be made in the component.

Treatment of Workaround for RATLC00586383 at This Release

RATLC00586383

The workaround for diff_merge defect RATLC00586383 was to copy richedit32.dll

into the clearcase\bin directory. Users running Version 2003.06.00 installations must
remove this file manually.

Treatment of Time Stamps by Windows and UNIX

Windows commands that display time stamps adjust for daylight saving time based
on the current DST setting rather than whether daylight saving time was in effect at
the time of the file modification. This is a deliberate behavior. As a result, the time
stamp output from a Windows command for a given file may be different from that
shown by cleartool or UNIX commands for the same file.

Adding a Large Number of Files from Windows Explorer

If you attempt to add a large number of files to source control from within Windows
Explorer, the operation fails. To add a large number of files to source control, use
the cleartool mkelem command instead.

MMC taskpads and the Admin Console

A defect associated with taskpads in the Microsoft Management Console, version 1.1
and 1.2, causes problems in the ClearCase Administration Console. The problem
occurs when you follow this sequence of steps:

1 Select the All VOBs or All Views node from the navigation bar of the Administration
Console. The program displays the associated taskpad.

2 Select a VOB or view tag from the taskpad list, and then click Manage storage.

3 After the storage for that node has been successfully displayed, click the MMC
back navigation arrow to return to and display the previously selected taskpad.

The taskpad list is blank.
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Use either of the following methods to work around the problem:

� In taskpad mode, select ViewTaskpad to turn off taskpad mode.

� Navigate to the taskpad with the back arrow and select Refresh from the All VOBs
or All Views node.

Note that with MMC 1.1, resizing the console window refreshes the list; resizing
has no effect in MMC 1.2

Checking In Identical .frm Files in Visual Basic 6.0

By default, ClearCase software does not create a new version of a file that is identical
to its immediate predecessor. When you attempt to check in a .frm file that is identical
to the checked-in version, the integration does not check it in. However, if the .frm file
has an associated .frx file, the integration checks in the .frx file as a read-only file. To
avoid this problem, set the option to allow identical checkins.

Displaying Logging Text Inside IDE

To enable logging text to be displayed inside an IDE, the user must set the registry key
HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion\SCC\DebugTrace = 1 (or
= 3 for additional logging to a file). This logging mechanism works for any IDE that
supports messages from an SCC provider.

The message Not a VOB Object appears if you click Add to Source Control. In this
case, the SCC proceeds to add the element to source control.

Problems with the Documentation

This section describes significant problems with the documentation and supplies
documentation that is missing from the manuals or the Help.

Browsing the Documentation with Netscape Navigator

If you use Netscape to browse HTML documentation, we recommend Netscape 7.

Omissions from the Command Reference

The diffbl reference page does not describe the -nmerge option. The correct syntax
for the first two usage modes of diffbl is as follows:

� Display differences between two baselines or streams nongraphically:
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diffbl [ -activities ] [ -versions ] [ -baselines ] [ -first_only]

[ -nrecurse ] [ -nmerge ] { baseline-selector1 | stream-selector1 } { baseline-selector2 |
stream-selector2 }

� Display differences between the specified baseline and its predecessor baseline
nongraphically:

diffbl -predecessor [ -activities ] [ -versions ] [ -nrecurse ]

[ -nmerge ] baseline-selector

The -nmerge option is used to compare two baselines on the same stream and reports
only activity and version changes made on that stream.

The protectvob reference page does not describe the pname-in-vob argument. The
correct syntax for this command is as follows:

protectvob [ -force ] [ -chown user ] [ -chgrp group ] [ -add_group group[,...]

[ -delete_group group[,...] ] vob-storage-pname | pname-in-vob } ...

pname-in-vob can be the pathname of the VOB tag (whether or not the VOB is mounted)
or of any file system object within the VOB (if the VOB is mounted). It cannot be the
pathname of the VOB storage directory.

The checkvob –ucm command supports a –verbose option, which directs the
command to generate more detailed output.

Omission from the Administrator’s Guide

The information that follows was omitted from the Administrator’s Guide.

If you install Rational Web Platform (RWP) on a host that was previously using a
different HTTP server to support version 4.2 or version 2002.05.00 of the ClearCase
Web interface and if that HTTP server must continue to run on that host to support
other applications, you must do the following:

1 Ensure that RWP and the existing HTTP server do not have any port conflicts.
(This topic is treated in the Administrator’s Guide)

2 Reconfigure the existing HTTP server to redirect Web interface requests to RWP.
See the documentation for your HTTP server for information on how to do this.

Omission from Managing Software Projects

The discussion of enabling a schema to work with UCM in Managing Software Projects
for Rational ClearCase omits an important step: mapping states to state types.

When you apply the BaseCMActivity package to a schema, ClearQuest adds the
BaseCMActivity record type. When you apply the UnitedChangeManagement (UCM)
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packages to the schema, ClearQuest adds the UCMUtilityActivity record type. But
when you attempt to check in the schema with these changes, ClearQuest displays
a series of validation errors stating that you need to map BaseCMActivity states to
the AMStates Types package.

You receive this error because, in applying the UCM package to the schema,
ClearQuest also applied the AMState Types package. This behavior is not described in
the Administrator’s Guide for Rational ClearQuest or in Managing Software Projects.

Before you can check in the schema, you must map states to state types from the
AMStates Types to the BaseCMActivity record type, as follows:

1 In ClearQuest Designer, click Package > Setup State Types.

2 In the Setup States Type dialog box, select a State Type for each State listed.

3 Click Finish.

4 Click File > Check in to record your changes in the schema.

For more information about mapping states and state types, see the Administrator’s
Guide for Rational ClearQuest. For more information about enabling the
BaseCMActivity record type, consult the Rational Support Knowledge Database.
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Status of
ClearCase LT
Software Change
Requests

4

Noteworthy problems found in or resolved in Version 2003.06.00 of Rational
ClearCase LT are listed in the file cc_issues.htm.

You can find this file in the folder ccase-home-dir\install\ after you install the product.
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Contacting Rational
Technical Support 5

If you have any problems with the software or documentation, contact Rational
Technical Support by telephone, fax, or electronic mail.

For information regarding support hours, languages spoken, or other support
information, click the Technical Support link on the Rational Web site at
www.rational.com.

Your location Telephone Facsimile Electronic mail

North
America

800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe,
Middle East,
and Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com
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